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Equations	
  

MS Excel is capable of making calculations automatically once the cells have been properly programmed. This 
feature can be used to make a single calculation, like in a calculator, or can be done on an entire row or column 
of data using the same formula. Any equation starts by typing “=” into the cell; this tells Excel that you want to 
calculate something, this is best demonstrated through an example: 

EXAMPLE 1: Calculating the Area of a circle with a radius of 5. The formula for calculating the area of a circle 
is ����=��2. We can do this calculation in Excel by setting up a spreadsheet, like the one shown in Figure 1, 
below. 

 
Figure 1: Calculating the Area of a Cirlce 
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In this example, Cell B2 was set to the value of Pi, and Cell C2 was set to the radius, so the equation required in 
Cell A2 was B2 multiplied by C2 squared. 

Almost any equation can be made by clicking on the cells that you want to use, with the correct mathematical 
operators (multiply, divide, add, subtract, etc). Excel automatically places the cell you click while in equation 
mode into the equation. 

Common mathematical operators are: 

• + Addition 
• - Subtraction 
• *Multiply 
• / Divide 

o the numerator goes on the left of the “/” and the denominator goes on the right 
o e.g.  3/8 is the Excel equation for three divided by eight 

• ^ Raise to the power of 
o x^y, the number x is raised to the power of y, this would appear in a mathematics textbook as 

��  
o In Example 1, above, the radius (cell C2) is squared, or raised to the power of 2, therefore the 

radius squared is C2^2 
• Parentheses 

o ( Open Parentheses 
o ) Closed Parentheses 
o Just like in “normal” mathematics, parentheses can be used to determine the order of operations 

in an equation. Excel uses the standard order of operations taught in mathematics textbooks. See 
Figure 1Figure 2, below, for the an example how the use of parentheses works in Excel. 
 

 
Figure 2: Use of Parentheses in Equations 

Absolute	
  and	
  Relative	
  Cells	
  

As mentioned above, Excel can do calculations on a set of data versus just a single point using the same 
formula, this is achieved by using what are called “relative cell references”. By clicking in the corner of an 
equation cell, and dragging in the direction of the data, Excel automatically changes the cells used in the 
formula; see Figure 3 and Figure 4, below for an example. 

 
Figure 3: Cell Corner Click and Drag 
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Figure 4: Equation Changes from Click and Drag 

As you can see, both the B column and C column numbers increase with each row, resulting in Figure 5. 

 
Figure 5: Results of Changing Cells 

So what happened? Cells B3, B4, and B5 are blank, and Excel reads these as zeroes: when Excel calculates 
B3*(C3^2), B4*(C4^2), and B5*(C5^2), it is multiplying by zero.  We can fix this two ways:  

1. a simple fix which involves filling in the blank cells (Figure 6), or 

 
Figure 6: Fill in the Blank Cells to Fix the Equation 

2. a simpler fix which involves setting a cell as constant using the “absolute cell reference”. 

We can set parts of a cell, or the entire cell to stay constant when it is used in an equation by adding dollar signs 
($) in front of the cell reference in the equation, as shown in Figure 7. 

 
Figure 7: Absolute Cell References 

You will notice that as we click and drag the equation down, once we have the dollar signs in front of B and 2, 
neither of them will change, this is particularly useful for referencing one cell over and over. If you only want to 
lock in the column position, you could type $B2, whereas if you wish to only lock in row, you could type B$2. 
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Play around with the position of the dollar sign in your cell references and how they change with clicking and 
dragging your equations to get a good feel for absolute cell referencing. 

Searching	
  for	
  Functions	
  

Excel comes equipped with a great many functions, many more than the average user will ever have need of. 
Excel’s vast library of functions comes with a handy tool for searching for the best function for what you want 
to do. To search for functions, click on the cell you want to add the function to, go to the “Formulas” tab, and 
select “Insert Function”, as illustrated in Figure 8. 

 
Figure 8: Navigating to Search for Functions Tool 

In the window that pops up, type what you want to do, and click “Go”. Excel will search through its database of 
functions and suggest several to you, look through them, select the function whose description best matches 
what you wish to do, and click “OK” to insert the function into the cell you selected, pictured in Figure 9. 

 
Figure 9: Function Search Tool Interface 
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Several	
  Useful	
  Functions	
  

Sum	
  

As its name suggests, the SUM function adds all the selected cells together. See Figure 10 for an example of 
how to use the SUM function. 

 
Figure 10: The SUM Function 

Average	
  

The AVERAGE function in effect adds the values of the selected cells and divides by the number of cells 
selected. This function is the same thing as finding the Mean of the data. See Figure 11 for an example of how to 
use the AVERAGE function. 

 
Figure 11: The AVERAGE Function 

Standard	
  Deviation	
  

The Standard Deviation of a set of data is a statistical measure of how widely the data varies, for example a very 
similar set of numbers would have a small standard deviation, whereas a very diverse set of numbers would 
have a large standard deviation. To highlight how important the standard deviation is, statistics are often 
reported as the average and the standard deviation. While the technical definition of standard deviation is 
somewhat complicated, it can easily be found in any Statistics textbook. 

Excel uses the shortened form of Standard Deviation, STDEV, as a function. See Figure 12 for an example of 
how to use the STDEV function. 
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Figure 12: The STDEV Function 

Sorting	
  

Among the more useful tools that Excel offers is the ability to sort a set a data based on several criteria. As 
above, it is best to illustrate the use of sorting by example. 

EXAMPLE 2: Sorting Temperature Data, First by Temperature, then by Year 

First we must select the data we wish to sort, including the data headers (they help to keep the sorting criteria 
straight), as shown in Figure 13. 
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Figure 13: Data Selection for Sorting 

Once the data to be sorted has been selected, navigate to the “Home” tab, click “Sort & Filter”, then drag down 
to “Custom Sort…”, as shown in Figure 14. 
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Figure 14: Navigate to Custom Sort 

In the window which pops up, make sure the “My data has headers” box is checked (otherwise the header names 
will not appear in the “Sort by” field). Select the criteria you want you data sorted by, then select the options 
you would like, as shown in Figure 15. 

 
Figure 15: Sort Criteria Selection 

If we stopped here, the data would only be sorted by Temperature, however we also want to sort it by Year if 
there are similar temperature entries for different years. Click “Add Level” and select the sort criteria for the 
next step of sorting, as shown in Figure 16. 
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Figure 16: Adding Levels of Sorting 

Once you have added all of the sorting levels you wish, click “OK”. Our data has now been sorted by 
Temperature, and then by Year, as shown in Figure 17. Compare Figure 13 and Figure 17 to see the “Before and 
After” of sorting. 
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Figure 17: Sorted Temperature Data 
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Paste	
  Special	
  

You may find as you use excel, that if you copy and paste cells with equations and formulas in them, that they 
do show the values you may have expected. Figure 18 shows a simple copy and paste of a standard deviation 
calculation, and Figure 19 shows how the cell references have changed. 

 
Figure 18: "Regular" Copy and Paste 

 
Figure 19: Changing Cell References in "Regular" Copy and Paste 

Most times, when a person performs a copy and paste, they only want the results of the calculation, and not the 
calculation itself, this is where the “Paste Special” tool comes in. To access the Paste Special tool, select and 
copy the cells you want, then right click in the cell you want to copy to, and scroll down to “Paste Special…” in 
the pop up menu, as shown in Figure 20. 

 
Figure 20: Navigating to the Paste Special Tool 

In the window that pops up, select the format you want the copied cells in, as seen in Figure 21, then click 
“OK”. Figure 22 shows the copied cells with the values only. 
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Figure 21: Paste Special Menu 

 
Figure 22: Results of Paste Special 

Find	
  and	
  Replace	
  

Excel can search a spreadsheet and find specific entries, it can also replace those entries it finds with something 
else. To use this tool, press “control” and “f” on the keyboard at the same time. Figure 23 shows the pop up 
menu for the find and replace tool. 
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Figure 23: Find and Replace Pop Up Menu 

Fill in the “Find What:” field with the entry you are looking to find, and if you want to replace it with 
something, also fill in the “Replace With:” field, then click “Find All” and “Replace All” to automatically find 
and replace all entries, or click “Find Next” and “Replace Next” to find and replace entries one by one. 

Graphing	
  and	
  Linear	
  Regression	
  

Excel can generate Graphs, Charts, Histograms, and other graphical representations of data. While only one 
chart type is shown here, the basic steps are the same for every chart. The “XY Scatter plot” is the example that 
will be shown here. 

To create an XY Scatter plot, go to the “Insert” Tab, and click on the small box in the bottom right of the 
“Charts” section, this opens the “Insert Chart” Tool, as seen in Figure 24. 
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Figure 24: The Insert Chart Tool 

On the left, select “X Y (Scatter)”, then select the first option (a small text box reading “Scatter with only 
markers” appears as you scroll over it), and then click “OK”. A blank graph will appear near your data. In the 
“Chart Tools”, “Design” tab, click “Select Data”. The “Select Data Source” Tool window will pop up. Click on 
“Add”, as shown in Figure 25. 
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Figure 25: The Select Data Source Tool 

Type a name for your data in the “Series Name:” text box, then click on the right sides of the “Series X values:” 
and “Series Y values:” text boxes to select the data for each. , then click “OK”, illustrated in Figure 26. 
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Figure 26: Selecting Data for X and Y Axis 

Your data will now show up in the “Select Data Source” Tool, as shown in Figure 27. If you want to put more 
data on the same graph, you may click “Add” again on the “Select Data Source” Tool, otherwise click “OK”. 
Your graph will now be made. 
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Figure 27: Completed Data Selection 

Many times data are graphed to determine whether there is some relation between the X and Y variables. To 
determine the relation mathematically and come up with an equation to model it, Linear Regression, or drawing 
a “Best Fit” line through the data points can be done. To perform a linear regression on your data, left click on 
one of your data points to select the dataset, then right click in the same spot to bring up a menu as illustrated in 
Figure 28.  

 
Figure 28: Navigating to "Add Trendline..."  
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On the menu, select “Add Trendline…” to open the “Format Trendline” Tool, shown in Figure 29. Click the 
“Linear” button, and the box next to “Display Equation on chart”. Figure 30 shows the resulting graph, with best 
fit line and equation. 

 
Figure 29: Format Trendline Tool 
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Figure 30: Completed Graph with Line and Equation 

Importing	
  “.csv”	
  and	
  “.txt”	
  files	
  

1. Open Microsoft Excel 
2. Click the “Office Button” on the top left 
3. Click “Open” on the menu 
4. To be able to find your file, you will likely need to change the “Files of type” field from “All Excel 

Files” to “All Files”. 
 

 
Figure 31: Selecting File Types 
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Figure 32: Looking at All Files in a Folder 

 
5. Select your file and press “Open” 
6. In the “Text Import Wizard” which pops up, select “Delimited” and then click “Next” 

 

 
Figure 33: The Text Import Wizard 

 
7. Nearly all modern text files are delimited with a space, a tab, or a comma, and all “.csv” files are comma 

delimited. When Excel recognizes a delimiter, it inserts a line between columns in the preview pane at 
the bottom of the “Text Import Wizard”. Try the different options to see what works best for your file. 
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Figure 34: Preview of Text Data with No Delimiters 

 

 
Figure 35: Preview of Text Data with Selected Delimiters 

 
8. When you are satisfied that you have chosen the correct delimiter, you may specify the format for your 

data in each row by pressing “Next”, or you may allow Excel to determine the format automatically by 
pressing “Finish” (Selecting “Finish” is suggested) 

	
  


